
EndNote 6.0 for PC       A Guide for the Students of Religion 401 

What is EndNote? 
 
EndNote is software that can help you keep track of the sources you use for a library research project: books and book 
chapters; articles in newspapers, magazines and scholarly journals; web sites; films or videorecordings; artworks; and other 
kinds of material. 
 
Use EndNote to build your own “library” of references—a database where you can record the bibliographic information 
(author, title, year, publisher, etc.) for individual sources.  Sometimes, you can import references directly into EndNote from 
research databases and library catalogs, minimizing retyping.   
 
Either way, you can use the information stored in EndNote to produce standalone bibliographies or to format citations and 
Works Cited lists in the research papers you write in Microsoft Word.  EndNote formats these citations more or less 
automatically. (See Disclaimer, below.) 

EndNote Argot 
 
EndNote has its own special vocabulary.  Listed below are terms that will be used in this guide. 
 
Library: a database made up of your sources’ bibliographic data (author, year, title, etc.). Library files end in .enl 
Reference: individual record in an EndNote library that includes information about a particular source. 
Reference Type: denotes what kind of source the reference is. Examples: book, book section, journal article, artwork. 
Field: part of a reference/record that includes a specific piece of data. Example: the “title field” contains the title. 
Styles aka Output Styles: helper files that enable EndNote to generate citations according to the rules of a specific citation 
style.  Example: Chicago A is a style. Style files end in .ens 
Style Manager: dialog box allowing you to select styles other than those currently accessible as “favorites.” 
Filters aka Output Filters: helper files that enable EndNote to import data from specific databases. Filter files end in .enf 
Filter Manager: dialog box that allows you to choose the correct filter when importing references from a database. 
EndNote Toolbar: appears in Microsoft Word and enables you to cite and format references within a Word document. 

Disclaimer 
 
Although EndNote automates much of the process of formatting citations, the program is no substitute for 
familiarity with the rules of your style guide.   
 
You must be comfortable with the rules for how to cite and understand the rules for when to cite in your given style.  
You yourself are responsible for the accuracy and honesty of the work you hand in. 
 
You may need to edit the EndNote-generated citations in your paper to reflect the rules of your citation style. 
(Examples: you might need to cite page numbers or omit author surnames in a parenthetical reference when the author 
has already been signaled in the surrounding sentence.) 
 
For Religion 401, we’ll be using the Chicago “A” style.  Find information on this style in any of the Diana Hacker guides 
or on the excellent web site: http://www.dianahacker.com/writersref   
You may also wish to consult the Chicago Manual of Style, 14th ed. (the new 15th ed. is on order at the Library). 
 
Note that the process of importing references may introduce errors that must be cleaned up for citations to display 
correctly. Occasionally, information may be imported into the wrong fields. Extra punctuation may appear.   
Imported references should be examined for accuracy and modified if necessary. 
 
Information from a previously imported reference should be checked against your personal examination of the item.  
Databases can include citation errors.  The same goes for items entered from other bibliographies. 
 
You may find that EndNote does not format citations for a particular reference type correctly.   
Please contact Shana with any problems you encounter. 
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Nuts & Bolts

Where Can I Use EndNote? 
 
EndNote is available for you to use on the PCs in the Library’s Woolley Electronic Classroom.  Wheaton has no site 
license for EndNote.   
 
You may wish to download a free, fully functional 30-day demo of EndNote 6.0 later on in the semester: 
http://www.endnote.com 
 
To allow the demo to produce citations in the appropriate styles and import new references you will need to install 
several small style and filter files.  Contact Shana for information. 
 
Getting Help with EndNote 
 
For EndNote questions, please contact Shana Gass, Reference/Instruction Librarian.  Drop by the Reference Desk on 
the main floor of the Library to ask for her, or contact her at sgass@wheatonma.edu or x3736. 
 
Other library staff may be able to help with EndNote in a pinch, but please plan ahead so there will be adequate time to 
get back to you if they are unable to do so.  Shana is usually here M-F, 9-5, but works at the Reference Desk Tuesday 
or Wednesday night until 10pm most weeks of the semester.  Shana is happy to answer particular questions or 
demonstrate features of EndNote whenever she is available. 
 
EndNote has an excellent online help feature.  Go to Help menu to browse contents or search.  You may also consult 
the PDF manual, in C:\Program Files\EndNote\EndNote6.pdf.  Chapter 3 is “The EndNote Guided Tour.” 
 
Using EndNote 
 
Opening EndNote 

Click on the EndNote icon on the Windows toolbar or use the Start Menu to find the program. 
 
Opening a Library 
Doubleclick the library’s icon, or open EndNote and Go to File >> Open >> find your library and click Open. 
 
Creating a New Library 
Open EndNote.  Go to File >> New and name and save new library. 
 
Adding a Reference Manually 
Go to References >> New or Control + N.  Select the appropriate reference type (Book, Journal Article, etc.) from the 
pulldown menu.  Type information in each field (or, at the minimum, in at least the fields required by your citation 
style), Tabbing to go to the next field.  When you are done, close the reference window (not the “outer” program 
window—click the X or Control + W) to save the individual reference and add it to your library. 
 
Hints: 
For Author and other name fields: Type Lastname, Firstname (followed by initials if any) 

Example: Jones, Jenny A. 
If multiple names, use Enter key to enter one person per line 
If a corporate name, insert a comma after the last word 

Example: Fellowship of Reconciliation, 
 
Special Fields:  
The Notes field is a great place for noting down your own thoughts on the source.  This is the field that is drawn upon 
when you select Chicago A – Annotated style (use this style for Assignment #2).   
 
If you import your reference rather than entering it manually, you may find that you need to omit (or move) odd bits of 
data from this field before entering your own notes. This field can hold up to 8 pages of single-spaced text. 
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Nuts & Bolts
 

 
Keywords field: If you import your references from a database/catalog, you will often find subject headings or other 
descriptors here.  These may be helpful when you go back to the resource to find other similar items.   
Additionally, you may want to add your own keywords to help you find particular references later on. 
 
Editing a Reference 
When in summary view of references, doubleclick the reference. Move through the fields as needed (Tab to move 
forward, Shift + Tab to move backward), editing as normal. 
 
Deleting a Reference 

Highlight the reference by clicking on it.  References  >> Delete References or Control + D. 
 
Previewing a Citation 
Select the appropriate style from the pulldown menu.  If your style is not displayed, go to Edit >> Style Manager and 
locate and check the box next to your style.  Click ok.  Go back to the pulldown menu and select the style. When you 
select a style, this will be the way EndNote formats your citations until you alter the selection. 
 
Highlight the reference by clicking it. Click Show Preview in the lower righthand corner of the EndNote window. 
EndNote will display the reference as formatted in the chosen style.  This is a good way to check whether all the 
needed information has been entered correctly, or whether extra punctuation must be removed.  
 
Importing References into EndNote 
 
Importing References from ELIZA, the Wallace Library Catalog 
1) Perform your search.  If you see a list of titles, check the boxes next to the ones you want.   
When you are done with the page, click on Save References. (Your checkmarks will disappear.)   
If you are in an individual record, simply click Export.   
 
You may save entries from more than one search, as long as you do not a) click Clear Saved Records b) close your 
browser or c) wait too long—there is a timeout after extended inactivity. 
 
2) Whenever you are ready to export your references, click Export Saved List. 
 
3) Select EndNote and the option to save to local disk.  Click Submit.  Save your file as a textfile (.txt) to a 
convenient, easy to find place, such as your Zip Disk or the computer’s desktop.  You may want to give the file a 
distinctive title—the default is export .txt. (If the records display on the screen, simply save the page as a text file.) 
 
4) Open the library to which you would like to import the references you chose.   

Go to File >> Import.   
In the Import dialog box, click Choose File and navigate to your saved text file. Click OK.   
For Import Option, choose EndNote Import.   
It is safest to Import All duplicates—you can find and eliminate them later.  
For Text translation, the default choice is fine.   
Click OK.   

 
5) Your new imported references will display.  Imported ELIZA records are a little messy.  You will notice extra 
punctuation. Author information may need to be moved around. Edited books may be imported simply as books; you 
will need to change the reference type to Edited Book for the citation to display correctly. Use Show Citation feature, 
personal examination of the item and your style guide in case there is any doubt. 
 
After doing the necessary clean-up, you may show all the records by References >> Show All or Control + H. 
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Nuts & Bolts
Importing References from Wilson Humanities Abstracts 
1) Perform your search.  Save items by checking the boxes next to specific titles.   
 
2) When you are ready to export your references, click on Citation Manager, or scroll to the bottom of the page; 
 
3) Select Complete Record, Direct Export and click on Save.   
 
4) A dialog box may come up asking how to handle the file.  If so, choose Open file and select EndNote 6.0 program 

as the handling application. EndNote should launch.  Select your library and click Open.  The new references 
should appear.   

 
5) Vet the references for accuracy before showing all the references again (Control + H). 
 
Importing References from ATLA Religion Index 
1) Perform your search. Save items by checking the boxes next to specific titles. 
 
2) When you are ready to export your references, click on the Disk icon.      
 
3) Select Complete Record, Record Number and Database Name, and Short Labels. Click Save. 
 
4) Save the file as a text file (.txt).   
 
5) Open the EndNote library to which you would like to import the references you saved.   

      Go to File >> Import.   
In the Import dialog box, click Choose File and navigate to your saved text file. Click OK.   
For Import Option, choose Other filters. Find & click on ATLA Religion (SP). Click OK. 
It is safest to Import All duplicates—you can find and eliminate them later.  
For Text translation, the default choice is fine.   
Click OK.   

 
6) The new references should appear in the library window.   
 
7) Vet the references for accuracy before showing all the references again (Control +H). 
 
Finding References in Your EndNote Library 

 

 
You may sometimes want to locate a certain reference  
or a category of references within your library.   
Let’s say you want to cite a reference in a paper, or you 
want to select specific references in preparation for 
creating a standalone bibliography (see below) from a 
subset of your library. 
 
 
Go to References >> Search (Control +F). 
You get the box shown on the right.  
 
 
Use the pulldown menus to search within particular 
fields, and to choose “contains,” “is,” or greater than/less 
than logic.   
 
You can select Boolean operators And, Or, or Not to 
combine searches.  Use And if both searching conditions 
must be met.  Click Perform Search to carry out search.  
You can carry out successive searches by using the 
pulldown “Search whole library.”  
 

 
Note:  Unless Match Words is checked, EndNote 
automatically truncates right and left.    
This means that a search for word (with March Words 
unchecked) would find sword, word, words, and wording. 
No special character is needed to truncate. 
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The Good Stuff
Creating a Standalone Bibliography 
 
Select the citations you will want to be using for your standalone document.   This can be done by means of a search 
(see above).  Or, select the ones you want to have in your bibliography by clicking on your choices, keeping the 
Control key pressed down.  Go to References >> Show Selected to “hide” the other records. 
 
Sort the citations the way you want them to come out in your bibliography.  (Click on the headings at the top of the 
right column, for instance, on AUTHOR). 
 
Select the output format you want.  Go to Edit >> Output Styles and select the one you want, or use the pulldown for 
favorite styles.  If the one you would want does not appear in the menu, go to the Style Manager (under Edit >> Output 
Styles) and click the box next to the style you want to have appear on your menu. Close the dialog box. Then go and 
select it from Output Styles or the pulldown Styles menu. 
 
Choose Export from File menu.  Give the file a name: You will want to use Rich Text Format on the pulldown menu.  
Make sure the filename ends in .rtf 
 
You should now be able to open up your file, either by doubleclicking the icon or by opening Microsoft Word and 
navigating to open the file (make sure “All Files” is selected for the pulldown).  Modify it however you like, give it a 
title, etc.  “It's yours to keep.”  You can now save it as a Word Document if you like.   
 
CAUTION:  Changes to your library will not affect this bibliography.  If it’s important to have the information be the 
same in the library, make the change in the library before exporting. 
 
Back in the library, Control + H  to show all the records in the library again when desired. 
 
 
Writing with EndNote: The Magic of “Cite while You Write” (CWYW) 
 
Ok, you’ve got your fabulous library of citations created and you are ready to start writing and citing. 
 
EndNote works with Microsoft Word to format citations according to the rules of your style.   
It does this by means of the EndNote Toolbar: 
 

 A B C D E F G   H I 

 
 

A. Find Citation(s) 
B. Go to EndNote 
C. Format Bibliography 
D. Insert Selected Citations 
E. Edit Citation(s) 
F. Insert Note 
G. Edit Library Reference(s) 
H. Cite While You Write Preferences 
I. Help 

 
The functions represented on the EndNote toolbar can also be found on the Tools Menu under EndNote 6. 
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The Good Stuff

Citing a Reference 

The first time you work with EndNote within a particular Word document, open the EndNote library you will 
be using also. 
 
Place your cursor in the Microsoft Word document where you want your citation. 
 
Chicago A is a style that uses footnotes.  Footnotes go after punctuation. 
 
Go to Insert >> Footnote 
 
Proceed by one of the following Methods: 
 

Method 1: Click Find Citation(s) icon [A]. A search box will appear.  Search for the relevant reference. 
Highlight the reference(s) you want by clicking on it/them and click Insert. 
 
Method 2: Click Go to EndNote icon [B]. In your library window, click on reference(s) you want to have cited. 
Go back to Microsoft Word document (either the regular way or Alt + 1). Click on Insert Reference icon [D]. 

 
Note that this simultaneously produces the footnote and a bibliography entry at the end of your document. 
 
Changing the Style 
Click Format Bibliography icon [C].  From the Format Bibliography tab, you can change the style you are 
using via the pulldown menu. Browse if you don’t see your style in the list. Find the style, highlight and 
click OK. 
 
Giving the Works Cited List a Title 
This is also under the Format Bibliography icon. Use the Layout tab.  You can modify the font here as well. 
 
To Edit Citations in a Document 
Once you have inserted and formatted a citation, you should not edit it directly (although you can do so, if you feel you 
must). Direct edits are lost the next time EndNote formats the bibliography.  
 
You can almost always get EndNote to format your citations exactly to your specifications by editing the style, the 
EndNote reference, or the citation (as described below). To safely edit a formatted citation: 
 
1) Click on the citation you wish to change. [You will see it turn grey, so you will know when it’s selected.] 
 
2) From Word’s Tools menu, select Edit Citation(s) icon [E] to display the Edit Citation dialog.  
 
3) If the citation you want to edit is part of a multiple citation, select the appropriate citation from the list at the left of 

the box. 
 
4) Make any of the following changes (only as required by Chicago A Style): 

Exclude Author:    Select this to omit the author name from the formatted citation. 
Exclude Year:       Select this to omit the date from the formatted citation. 
Prefix:     Enter text here to print immediately before the citation text (spaces are significant). 
Suffix:     Enter text here to print immediately after the citation text (spaces are significant). 
Pages:     Enter page numbers here to print immediately after the citation, and after suffix text. 

 
5) In a multiple citation, highlight a reference and use the up & down arrows to change the order of display. 

 
6) Click OK to implement the change(s) to the citation. 

HAVE FUN – ENJOY YOUR RESEARCH – AND ASK QUESTIONS IF NEEDED! 
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